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ERKLÄRENDE UNTERLAGEN: SIGIL (EPUB) 
 
Zur Erinnerung: Diese Roadmaps ermöglichen ein besseres Verständnis der Arbeitsabläufe bei 
der Produktion digitaler interaktiver Inhalte durch praktische Empfehlungen und 
Erfahrungsberichte von Fachleuten. 
Auf diese Weise wollen wir Lernende und Lehrende beim Lernen, aber auch nach der 
Ausbildung, in ihrem praktischen Arbeitsleben unterstützen. 
 

1. Über die Technologie 
 

Die verwendete 
Technologie 
 

ePub 

Ziele und Ergebnisse Erstellung eines digitalen Buches im ePub3-Format, das dank einer 
Leseanwendung auf einem Computer, Tablet oder Telefon verfügbar 
ist. 

Beschreibung 
 
 

ePub ist ein Format, das die Erstellung von digitalen Büchern, auch 
eBooks genannt, ermöglicht. Das ePub3 (aktuelle Version) erlaubt 
die Integation von Ton, Video und Interaktivitäten. Diese Art von 
digitalen Büchern ist für Sehbeeinträchtigte zugänglich. 

Verwendetes 
Medium (Computer, 
Tablet, Handy) 

Das digitale Buch ist mit Hilfe einer Leseanwendung auf einem 
Computer, Tablet und Mobiltelefon lesbar. 

Wo wird der Inhalt 
zugänglich sein (App, 
Plattform, 
Webseite…) 

Dank einer Leseanwendung ist das ePub auch ohne Internet lesbar. 
Die folgenden Anwendungen ermöglichen das Lesen des ePub. Apple 
Books (für Apple-Geräte), Readium (für Computer) und Lis-a (für 
Android-Geräte). 

Wie lange hat die 
Entwicklung 
gedauert? 

Die Entwicklungszeit eines ePubs hängt von der Menge der Inhalte 
ab, die hinzugefügt werden sollen. Für diese Übung benötigst du ca. 
40 Minuten:  

 Herunterladen der Software: 5 Minuten  

 Die Elemente finden: 10 Minuten  

 Entwerfen: 25 Minuten  

 Extrahieren: 1 Minute 
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2. Verwendete Software 
 

Name der Software 
 

Sigil 

Name des 
Unternehmens 

Entwickelt von Strahinja Markovic 

Copyright Status 
(cc, Urheberrecht, 
etc) 

Sigil ist ein Open-Source-Verleger von digitalen Büchern, d.h. die 
Lizenz dieser Software respektiert Kriterien, die von der Open-
Source-Initiative genau festgelegt wurden: die Möglichkeiten der 
freien Weiterverbreitung, den Zugang zum Quellcode und die 
Erstellung abgeleiteter Werke. 

 
Zusätzliche Ressourcen die für die Inhalte verwendet wurden: 

Das mit der Software Sigil im ePub3-Format produzierte digitale Buch besteht aus Text, Bild 
und Ton. 
 

 
3. Kosten 

 

Kosten für die 
Erstellung der Inhalte 
mit dem Tool 

- 

Allgemeine Gebühren  - 

 
Kosten für etwaige zusätzliche Ressourcen: 

Die Software ist kostenlos und der Inhalt ist urheberrechtsfrei 
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4. Produktionsschritte 
 

Designphase 
 

Warum wurde dieser Inhalt 
erstellt? 
 
 

Da das E-Book ein elektronisches Medium ist, verfügt es 
über zusätzliche Funktionen, die ein Papierbuch nicht hat, 
wie z.B. Ton oder bewegte Bilder. E-Books sind auch 
interaktiv, da es möglich ist, Links zu mehreren 
Datenquellen zu haben: zusätzliche Videos, Hyperlinks, 
usw. Diese Optionen machen es für Nutzerinnen und 
Nutzer lustig und unterhaltsam. Digitale Bücher bieten 
auch eine soziale Öffnung zur Welt für Menschen mit 
Beeinträchtigungen. Einige Funktionen, wie z. B. die 
Möglichkeit, die Schriftgröße zu vergrößern, erleichtern 
vielen Menschen das Lesen. Darüber hinaus sind auch die 
Verwendung von Audio als Unterstützung für Text oder 
das Hinzufügen verschiedener Videos sehr nützlich und 
würden es ermöglichen, Bücher zu gestalten, die an 
Menschen mit Beeinträchtigungen angepasst sind. 
 

Welche Funktionalitäten hat es?  
 

Das ePub enthält Text, Bilder, Video, Ton und Hyperlinks. 

Was ist der Zweck? 
(pädagogisch, Kommunikation, 
Spiele, etc.) 

Das Ziel der Erstellung eines ePubs ist pädagogischer 
Natur. Die Frage muss gestellt werden, wie eine 
bestimmte Menge an Informationen übermittelt werden 
können und wie die Inhalte in einem Buch formatiert 
werden müssen. 

 
 

5. Erstellungsphase 
 

Vorbereitungen Um diese Software zu verwenden, empfehlen wir, den Inhalt (Text, Bild, 
Ton) bereits in einem Ordner vorzubereiten. Jeder Inhalt muss korrekt 
umbenannt werden (Bild1, Bild2 usw.). Zögere nicht, lizenzfreie Bilder und 
Töne zu verwenden. Viele Inhalte findest du in Bild- und Tondatenbanken 
im Internet. 

Metadaten Bevor du mit der Erstellung eines ePubs beginnst, musst du das neue 
Dokument speichern. Gehe dazu auf File → Save As, vergib einen Namen 
(Beispiel: the_planets) und speichere es dann, wo du willst. 
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Es ist dann notwendig, dem ePub einen Titel zu geben. Klicke dazu nur auf 
das rosa "M" in der Symbolleiste und fülle die Zeile [Title here] aus. 
 

 
 

Deckblatt 
hinzufügen 

Um dem EPUB ein Cover hinzuzufügen, gehe zu Tools → Add Cover. Für 
diese Übung wird das Bild "cover.png" verwendet. Eine neue Seite 
cover.xhtml wird automatisch im Browser-Menü des Buches erstellt. 
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Hinzufügen von 
Text und 
Modifizieren 
seiner CSS-
Eigenschaften 

Du kannst deinem Buch einen Text hinzufügen und es ist auch möglich, 
die Eigenschaften dieses Textes zu ändern: kursiv, fett usw. 
Mit Doppelklick auf Section0001.xhtml, du gelangst auf eine neue leere 
Seite (weitere kannst du hinzufügen mit Rechtsklick auf Text > Add Blank 
HTML File). Um Text hinzuzufügen, kopiere ihn einfach aus einem anderen 
Dokument und füge ihn ein oder schreibe ihn direkt in die Seite. Und zwar 
im Body zwischen <body> und </body>. 
  
Um Text kursiv zu schreiben, platziere ihn einfach zwischen den Tags <i> 
</i> und für fett geschriebenen Text, verwende die <b> </b> Tags. Absätze 
kannst du mit <p> </p> erzielen und Zeilenumbrüche mit </br>. 
Um den Text zu formatieren, erstelle einen Stylesheet mit rechtem 
Mausklick auf den Ordner Styles und dem Befehl Add Blank Stylesheet. 
Verknüpfe den Stylesheet mit deinen Buchseiten in dem du auf jeder 
bereits angelegten Seite (Section0001.xhtml, Section0002.xhtml, …) 
jeweils zwischen den beiden <head> Tags diesen Text einfügst: 
<link rel="stylesheet" href="../Styles/Style0001.css" type="text/css" />  
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Audio 
hinzufügen 
 

Es ist möglich, Tonspuren hinzuzufügen. Es kann eine Erzählerin oder ein 
Erzähler sein oder eine Musik z. B. eine Klangatmosphäre. Um einen Ton 
hinzuzufügen, klicke auf das orangefarbene Bildsymbol in der 
Symbolleiste. Klicke dann auf Other files und wähle die Datei aus. 
 
Achtung: die Datei wird an der Stelle des Buches eingefügt, an der du 
gerade mit deinem Cursor stehst. 
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Ein Bild 
hinzufügen und 
seine 
Eigenschaften 
ändern 

Es gibt auch die Möglichkeit, das Buch mit Fotografien, Illustrationen und 
animierten Bildern zu erweitern. Um ein Bild einzufügen, mache einfach 
die gleichen Schritte wie beim Einfügen vom Ton. Klicke auf das 
orangefarbene Bildsymbol in der Symbolleiste und füge das Bild ein. 
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Um Bilder zu vergrößern oder zu verkleinern usw. musst du dem Bild eine 
Klasse verleihen und kannst dann im Stylesheet die Änderungen 
vornehmen: Für diese beiden Bilder füge class="petite" im Tag <img> 
hinzu: 

 
 
Jetzt kannst du die Änderungen im Stylesheet vornehmen (Achtung die 
Klasse des Bildes muss auch hier gleich heißen – in unserem Fall „petite“): 

 
 

Einen Internet-
Link hinzufügen 

Du kannst das Buch mit zusätzlichen Inhalten wie z. B. Hyperlinks 
erweitern. Diese Internet-Links können zu Videos, Artikeln usw. führen. 
Um einen Hyperlink zu erstellen, schreibe einfach den Text der im Buch 
sichtbar und anklickbar werden soll in den Body und markiere ihn. Klicke 
dann auf das Link-Symbol in der Symbolleiste (violette Kette) und fülle das 
Feld "Target" mit dem Link aus. Der Text wird automatisch zwischen den 
<a> </a> Tags eingefügt. 
 

 
Überprüfung 
der Gültigkeit 
des ePub 

Klicke auf Tools > Validate EPUB (oder Well-Formed Check EPUB), um eine 
vollständige Gültigkeitsprüfung der Datei durchzuführen. Mängel werden 
in einem Fenster unterhalb des Hauptbereichs angezeigt. Sie müssen nach 
und nach korrigiert werden, um sicherzustellen, dass das Dokument für 
alle lesbar ist. 
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Lese das eBook Wenn du die Datei unter File > Save speicherst, wird diese automatisch im 
ePub-Format gespeichert. Du kannst das ePub nun mit einem 
Leseprogramm (z. B. eBook Reader, Apple Books) öffnen oder einige 
Punkte ändern, wenn dir das Layout nicht zusagt. Du kannst zur ePub-
Datei zurückkehren, so oft du willst, um sie zu ändern! 

 
 

6. Testphase 
 
Wurde das Werkzeug von jemandem getestet?  

Anzahl der User  20 Lernende 

User-Gruppen (Lehrer, 
Jugendliche, Fachleute 
etc.) 

Studierende in 2 Master-Lehrgängen “Multimediale redaktionelle 
Erstellung” 

Kumulierte Zeit der 
Prüfung durch die 
Benutzer 
 

2 Stunden 30 Minuten 

 
Beschreibung des Tests 

 Vorstellung verschiedener angereicherter digitale Publikationen 

 Gemeinsame Identifikation der innovativen Akteure (Design, Produktion, Vertrieb) in 
diesem Bereich 

 Diskussion zu Möglichkeiten und Einschränkungen des angereicherten epub3-
Formats 

 Nachbauen des Modells mit den Teilnehmenden im epub3 FXL-Format 

 
Was wurde daraus gelernt? 

 Identifizierung der Möglichkeiten und Einschränkungen des epub3-Formats 
(Reflowable & Fixed Layout) 

 Entwurf einer angereicherten Publikation und Erstellung der zugehörigen 
Arbeitspapiere 

 Erstellen einer angereicherten Publikation mit Sigil 

 
Wurden nach dem Test Inhalte geändert? 

Nach diesem ersten Test wurde ein Treffen hinzu, um das Thema ausführlicher vorzustellen. 

 
Wenn ja, Beschreibung der Änderungen: 
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Um dieses Projekt vorzustellen, wurde eine Demonstrationssitzung bestehender Inhalte mit 
einer Analyse der innovativen Konzepte durch die Lernenden inkludiert. 
- Neue Arten des Erzählens 
- Überblick über die Werkzeuge zur Erstellung/Realisierung 
- Lesemedien, Hardware und Software (Unterschiede und Kompatibilität) 
- Diffusions- und Verteilungsmodi 

 
Veröffentlichung 
 

Wo wurde das Tool 
veröffentlicht? 
 

Das digitale Buch wurde bei Google Books (Google Play) 
veröffentlicht. 

Warum? Wir haben diesen Store gewählt, um das Buch für alle 
zugänglich zu machen 

Sind bei diesem Schritt 
Schwierigkeiten aufgetreten? 

Die einzige Schwierigkeit, war die Zeit für die Vergabe einer 
ISBN. 

Wenn ja, welche? 
 
 
 

Um das Buch auf Google Play zu veröffentlichen, musst du 
selbst eine ISBN angeben. Wir mussten eine ISBN bei der 
AFNIL (Frankreich) beantragen. 

 
 

7. Inklusiver Ansatz 
 

 Welche Maßnahmen wurden ergriffen, um dieses Werkzeug so vielen Benutzern wie möglich 
zugänglich zu machen? 
 

Digitale Buchfunktionen wie vergrößerte Schriftgröße, Audio und Video sind nützlich, weil sie 
das Lesen für Menschen mit Schwierigkeiten beim Sehen erleichtern. 
 

 
 
 
 
 
 
 
 
 
 



 

The #DIMPAproject has been funded with support from the European Commission. Its content and material reflect the views only of the authors, and the Commission 

cannot be held responsible for any use which may be made of the information contained therein. Project code: 2018-1-FR01-KA202-048220 

Gute / Schlechte Praktiken 
 

Wird diese Software 
empfohlen? 
 

Ja 

Erläuterung 
 

Sigil ist eine freie und quelloffene Software, mit der du Dateien 
im ePub-Format erstellen kannst. Es macht es auch einfach, 
Metadaten in ePub aufzunehmen. Es ist für MAC, Linux und 
Windows verfügbar. 

 
Empfehlungen für die Erstellung von Inhalten mit dieser Technologie: 
 

Achtung, es erlaubt nur die Erstellung von mitfließenden (reflowable) ePubs. Das mitfließende 
ePub hat ein "flüssiges" Layout, das sich an jedes Medium anpassen lässt. Die Leserin bzw. der 
Leser wählt die Anzeigeoptionen aus: Schriftart, Hintergrundfarbe, Ränder. Der Text passt sich 
automatisch an. Im Gegensatz zum festgelegtem (fixed-layout) ePub, das das Layout eines 
Dokuments vollständig respektiert. Im Falle eines ePub von Sigil können die Anzeigeoptionen 
geändert werden. Dies mag für Buchverleger unbequem sein mag, weil sie sich ein bestimmtes 
Layout vorgestellt haben, ist aber gleichzeitig für Leserinnen und Leser von Vorteil, da das 
Buch entsprechend der eigenen Lesart angepasst werden kann. 
 
Um diese Software zu benutzen, empfehlen wir, den Inhalt (Text, Bild, Ton) bereits in einem 
Ornder vorzubereiten. Jeder Inhalt muss korrekt umbenannt werden (Bild1, Bild2 usw.). 
Zögere nicht, lizenzfreie Bilder und Töne zu verwenden, du kannst viele Inhalte in Bild- und 
Tonbanken im Internet finden. 

 
 


